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Abstrak 

 
Dalam pelaksanan proyek tidak dipungkiri adanya hambatan- hambatan dalam pelaksanaan proyek seperti 

pengaruh cuaca, perubahan desain, maupun keterlambatan suplai material. Apabila hal ini terjadi maka pihak 

kontraktor harus meiliki cara untuk menghadapi situasi ini salah satunya dengan penambahan jam kerja  yang 

bertujuan untuk percepatan pelaksanaan pekerjaan. Salah satu metode yang dapat digunakan adalah Time Cost Trade 

Off atau pertukaran waktu dan biaya. Alternatif percepatan yang digunakan dalam penelitian ini adalah penambahan 

jam kerja. Tujuan penelitian ini adalah  mengetahui waktu yang dapat dipersingkat serta biaya yang dibutuhkan 

untuk menyelesaikan proyek tersebut. Hasil penelitian menunjukan bahwa dengan menambahkan jam kerja  3 jam  

pada pekerjaan kritis, pekerjaan dapat dilakukan selama 159 hari mengahsilkan efesiensi waktu 44 hari. Biaya 

adalah sebesar  Rp    806.088.888,406 dari biaya normal sebesar  Rp  701.471.381,330 dengan cost slope sebesar  

Rp  104.617.507,076. Persentase cost slope dengan biaya total proyek adalah 5,96 % dimana total biaya keseluruhan 

proyek adalah Rp 1.754.274.213.38. Cost slope merupakan konsekuensi yang harus disepakati pihak kontraktor. 

 

Kata kunci: Lintasan Kritis, Penambahan Jam Kerja, Time Cost Trade Off  (TCTO) 

 

 

 

I. PENDAHULUAN 
 

Dalam pelaksanan proyek tidak dipungkiri 

adanya hambatan- hambatan dalam pelaksanaan 

proyek seperti pengaruh cuaca, perubahan desain, 

maupun keterlambatan suplai material. Apabila hal 

ini terjadi maka pihak kontraktor harus meiliki cara 

untuk menghadapi situasi ini sebagai konsekuensi 

kontraktor di lapangan, salah satunya dengan 

penambahan jam kerja yang bertujuan untuk 

percepatan pelaksanaan pekerjaan.  

Hal ini tentu saja  sangat berarti bagi pihak 

kontraktor sebagai pelaksana di lapangan. Akan 

tetapi, percepatan yang dilakukan tidak boleh 

sembarangan. Faktor biaya dan standar mutu harus 

tetap diperhatikan agar pihak kontraktor tidak 

merugi dan hasil kerjanya tetap mempunyai kualitas 

yang baik. Oleh karena itu, harus diperhitungkan 

dengan teliti agar durasi proyek tepat sesuai yang 

dijadwalkan dan biaya yang dikeluarkan tidak 

membengkak. 

Untuk mengetahui hal ini perlu dipelajari 

tentang jaringan kerja yang ada, hubungan antara 

waktu dan biaya yang disebut sebagai Analisis 

Pertukaran Waktu dan Biaya. Tujuan dari metode 

ini adalah mempercepat waktu pelaksanaan proyek 

dan menganalisis sejauh mana waktu dapat 

dipersingkat penambahan biaya minimum terhadap 

kegiatan yang bisa dipercepat kurun waktu 

pelaksanaannya sehingga dapat diketahui 

percepatan yang paling maksimum dan biaya yang 

paling minimum. Metode pertukaran waktu dan 

biaya (time cost trade off method) memberikan 

alternatif kepada perencana proyek untuk dapat 

menyusun perencanaan yang terbaik sehingga 

upaya mengoptimalkan waktu dan biaya dalam 

menyelesaikan suatu proyek dapat dilakukan. 
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II. METODE PENELITIAN 
 

A. Data Proyek 

Fasilitasi Revitalisasi Infastruktur Fisik Ruang 

Kreatif  dan Sarana Ruang Kreatif profil proyek 

konstruksi : 

Pekerjaan : Pembangunan Gedung Aula 

Nurul Jabbal 

Biaya proyek : Rp 1.754.274.213.38 

Lokasi proyek : Jalan Raya Bojong Kampung.  

Sarongge Sukadami  Kecamatan 

Cicantayan Kabupaten  

Sukabumi 

Luas bangunan : 858 M
2
 

 

B. Analisis Data 

1. Menghitung durasi pekerjaan dan kebutuhan 

pekerja 

Durasi pekerjaan dihitung sebelum membuat 

penjadwalan kerja dengan bantuan program Ms. 

Project agar diketahui pekerjaan yang diperkirakan 

akan terlambat. Durasi untuk setiap pekerjan dapat 

dihitung menggunakan rumus :  

𝑫𝒖𝒓𝒂𝒔𝒊 (𝒉𝒂𝒓𝒊) =    
 𝒐𝒍𝒖𝒎𝒆   𝒌𝒐𝒆𝒇𝒆𝒔𝒊𝒂𝒏

𝒋𝒖𝒎𝒍𝒂𝒉 𝒕𝒆𝒏𝒂𝒈𝒂 𝒌𝒆𝒓𝒋𝒂
         (1)                  

Indeks atau koefisien tenaga kerja didapat dari 

data yang terdapat pada PERMEN PUPR28-2016 

dan SNI. Kebutuhan tenaga kerja awal adalah hasil 

estimasi. Kemudian dapat dihitung ulang setelah 

diketahui durasi dengan menggunakan rumus: 

𝑲𝒆𝒃𝒖𝒕𝒖𝒉𝒂𝒏 𝒕𝒆𝒏𝒂𝒈𝒂 𝒌𝒆𝒓𝒋𝒂 =   
 𝒐𝒍𝒖𝒎𝒆   𝒌𝒐𝒆𝒇𝒆𝒔𝒊𝒂𝒏

𝒅𝒖𝒓𝒂𝒔𝒊
      

 (2)       

2. Membuat penjadwalan kerja.  

Analisis penjadwalan kerja dilakukan dengan 

cara input durasi awal lalu membuat jaringan kerja 

(network planning) agar diketahui jalur kritis dari 

pekerjaan tersebut. Langkah langkah yang 

digunakan untuk menyusun rencana jadwal proyek 

menggunakan Microsoft Project sebagai berikut: 

a. Membuka aplikasi atau lembar kerja baru  

Klik tombol Start > Program > Microsoft 

Project > Blank Project 

b. Menentukan tanggal dimulainya proyek 

Klik menu Project > Project Information. Pada 

kotak dialog Project Information dipilih 

Schedule From: Project Start Date dan 

memasukan tanggal dimulainya proyek pada 

kotak Start Date 

c. Memasukan kegiatan proyek 

Untuk memasukan data kegiatan proyek 

pertama-tama adalah membuat urutan pekerjaan-

pekerjaan yang dilakukan pada pekerjaan 

pembangunan aula Nurul Jabbal dengan 

mengetikannya pada kolom Task Name dan 

waktu kegiatan pada kolom Durasi. 

d. Memasukan pekerja keiatan proyek  

Untuk memasukan Pekerja pada kegiatan proyek 

pertama-tama adalah membuat urutan jenis 

pekerja yang dilakukan pada pembangunan 

gedung aula Nurul Jabbal dengan 

mengetikannya pada kolom Resource Name. 

e. Membuat hubungan pekerjaan 

Membuat hubungan pekerjaan satu dengan yang 

lainnya pada kolom Predecessor. 

f. Membuat kalender kerja 

Menyusun kalender kerja bertujuan untuk 

menentukan hari kerja dan jam kerja, dengan 

cara klik menu Project > Change Working 

Time > Options > Schedule. 

g. Menampilkan lintasan kritis 

Caranya simpan kursor dibagian tracking 

gantt > klik kanan pilih show/hide bar style > 

pilih critical task. Maka akan terlihat kegiatan-

kegiatan kritis dengan warna merah. 

h. Hasil lintasan kritis metode Precedence 

Diagram Network (PDM) 

Caranya simpan kursor dibagian gantt chart 

sebelah kiri > klik kiri pilih network diagram. 

Maka akan terlihat bentuk diagram PDM. 

 

3. Menentukan normal cost ( biaya normal) 

Normal cost didapatkan dari nilai RAB yang 

bersumber dari data proyek. Perhitunganya adalah 

sebagai berikut :  

 𝒐𝒓𝒎𝒂𝒍 𝒄𝒐𝒔𝒕  𝒃𝒊𝒂 𝒂 𝒍𝒂𝒏𝒈𝒔𝒖𝒏𝒈 
                                    𝒃𝒊𝒂 𝒂 𝒕𝒂𝒌 𝒍𝒂𝒏𝒈𝒔𝒖𝒏𝒈   (3) 

 𝒊𝒂 𝒂 𝒕𝒊𝒅𝒂𝒌 𝒍𝒂𝒏𝒈𝒔𝒖𝒏𝒈      𝒏𝒐𝒓𝒎𝒂𝒍 𝒄𝒐𝒔𝒕 
 (4) 

 𝒊𝒂 𝒂 𝒍𝒂𝒏𝒈𝒔𝒖𝒏𝒈  𝒏𝒐𝒓𝒎𝒂𝒍 𝒄𝒐𝒔𝒕  
                                   𝒃𝒊𝒂 𝒂 𝒕𝒂𝒌 𝒍𝒂𝒏𝒈𝒔𝒖𝒏𝒈  (5) 

 

C. Analisa Time Cost Trade Off (TCTO)  

Time cost trade off merupakan kompresi jadwal 

untuk mendapatkan proyek yang lebih 

menguntungkan dari segi waku (durasi), biaya, dan 

pendapatan. Tujuannya  adalah memampatkan 

proyek dengan durasi yang dapat diterima dan 

meminimalisasi biaya total proyek. Time cost trade 

off adalah suatu proses yang disengaja, sistematik, 

dan analitik dengan cara melakukan pengujian dari 

semua kegiatan dalam suatu proyek yang 

dipusatkan pada kegiatan yang berada pada jalur 

kritis. Ada beberapa alternatif yang dapat dilakukan 

yaitu[1]:  

1. Penambahan jam kerja   

Kerja lembur dapat dilakukan dengan 

menambah jam kerja setiap hari dengan sumber 

daya yang sama tanpa menambah tenaga kerja. 
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Indikasi dari penurunan produktivitas pekerja 

terhadap penambahan jam kerja  dapat dilihat pada 

Gambar 1. 

 
Gambar 1 Grafik indikasi penurunan produktivitas 

karena kerja lembur. 

 

Tabel 1 Koefisien penurunan produktivitas  

Jam 

Lembur 

Penurunan Indeks 

Produktivitas 

Prestasi 

Kerja (%) 

1 0,1 90 

2 0,2 80 

3 0,3 70 

4 0,4 60 

Dengan mempercepat durasi proyek maka akan 

menyebabkan perubahan terhadap biaya dan waktu. 

Penambahan biaya akan memberikan besaran 

perbedaan biaya akibat percepatan waktu sesuai 

dengan banyaknya waktu percepatan. Besarnya 

penambahan biaya per satuan waktu dinyatakan  

dengan Cost Slope (CS) yang dapat dihitung untuk 

tiap jenis kegiatan yang dipercepat.  

 

2. Penambahan Tenaga Kerja  

Penambahan jumlah tenaga kerja pada sub 

pekerjaan tertentu tanpa menambah jam kerja. 

Dalam penambahan jumlah tenaga kerja perlu 

diperhatikan ruang kerja yang tersedia. 

 

3. Pergantian Atau Penambahan Peralatan  

Perlu diperhatikan akan adanya penambahan 

biaya langsung untuk mobilisasi dan demobilisasi 

alat tersebut.  

4. Pemilihan Sumber Daya Manusia Yang 

Berkualitas  

Yang dimaksud dengan sumber daya manusia 

yang berkualitas adalah tenaga kerja yang 

mempunyai tingkat produktivitas yang tinggi 

dengan hasil yang baik.  

5. Metode Konstruksi Yang Efektif  

Metode konstruksi berkaitan erat dengan sistem 

kerja dan tingkat penguasaan pelaksana terhadap 

metode tersebut serta ketersediaan sumber daya 

yang dibutuhkan.  

Penambahan dari jam kerja (lembur) ini sangat 

sering dilakukan dikarenakan dapat 

memberdayakan sumber daya yang sudah ada 

dilapangan dan cukup dengan mengefisienkan 

tambahan biaya yang akan dikeluarkan oleh 

kontraktor. Biasanya waktu kerja normal pekerja 

adalah 8 jam (dimulai pukul 08.00 dan selesai pukul 

17.00 dengan satu jam istirahat), kemudian jam 

lembur dilakukan setelah jam kerja normal selesai . 

Produktivitas (harian, tiap jam, harian setelah 

percepatan), dan Crash duration dirumuskan 

sebagai berikut:  

a. Produktivitas harian normal 

                𝒂  
 𝒐𝒍𝒖𝒎𝒆

𝑫𝒖𝒓𝒂𝒔𝒊  𝒐𝒓𝒎𝒂𝒍
                               (6)  

b. Produktivitas tiap jam normal  

                𝒃  
𝒂

 𝒂𝒎 𝑲𝒆𝒓𝒋𝒂  𝒆𝒓𝒉𝒂𝒓𝒊
                          (7)  

c. Produktivitas harian setelah percepatan  

                𝑐 = 𝑎 + (𝑏 𝑥 𝑛 𝑥 𝑦)                          (8)  

d. Crash Duration 

                      𝒅  
 𝒐𝒍𝒖𝒎𝒆

𝒄
                             (9) 

Dimana,  

𝑎  =  produktivitas harian normal  

𝑏  =  produktivitas tiap jam normal  

𝑐  =  produktivitas harian setelah percepatan  

𝑑  =  crash duration 

𝑒  =  crash cost  

𝑛  =  lama penambahan jam kerja (lembur)  

𝑦  =  koefisien penurunan produktivitas akibat 

penambahan jam kerja (lembur) 

e. Crash Cost 

Penambahan waktu kerja akan menambah besar 

biaya untuk tenaga kerja dari biaya normal tenaga 

kerja. Berdasarkan Keputusan Menteri Tenaga 

Kerja dan Transmigrasi Republik Indonesia Nomor 

KEP. 102/MEN/VI/2004 pasal 3, pasal 7 dan pasal 

11 diperhitungkan bahwa upah penambahan kerja 

bervariasi. Pada penambahan waktu kerja satu jam 

pertama, pekerja mendapatkan tambahan upah 1,5 

kali upah perjam waktu normal dan pada 

penambahan jam kerja berikutnya maka pekerja 

akan mendapatkan 2 kali upah perjam waktu 

normal [2]. Crash cost untuk penambahan jam kerja 

(jam lembur) dapat dicari dengan langkah-langkah 

sebagai berikut:  

f. Upah normal/hari  

=  produktivitas harian normal x biaya satuan 

upah                                          (10) 

g. Upah normal/jam  

 =  produktivitas tiap jam normal x biaya satuan 

upah                                  (11)  

h. Upah lembur perhari 

 =  1,5 x upah sejam normal untuk jam kerja 

lembur pertama dan 2 x upah sejam normal 

untuk jam kerja berikutny  (12) 
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i. Cost upah perhari  

 =  Upah normah/hari + upah lembur perhari                                   

    (13) 

j. Cost upah total  

 =  cost upah /hari x durasi percepatan  (14)  

k. Cost bahan  

 =  volume x biaya satuan bahan              (15)  

l. Crash Cost 

 =  Cost upah total +cost bahan             (16)  

Tahapan penelitian secara skematis dalam bentuk 

diagram alir dapat dilihat pada Gambar 2. 

 
Gambar 2. Diagram Alir 

 

III. HASIL DAN PEMBAHASAN 
 

A. Durasi Pekerjaan 

Setelah diihitung menggunakan rumus durasi 

pada seluruh pekerjaan pembangunan gedung aula 

Nurul Jabbal didapat hasil durasi normal untuk 

seluruh pelaksanaan kerja adalah 203 hari. 

 

B. Penjadwalan Kerja 

Penjadwalan kerja menggunakan bantuan 

Microsoft Project 2010. 

 

 

 

 

 

 

Tabel 2  Penjadwalan Gedung Aula Nurul Jabbal 

Task Name Duration Start Finish Predecessors 

PEKERJAAN 

PEMBANGUNAN 

AULA NURUL 

JABBAL 

194 

days 

Mon 

6/1/20 

Thu 

2/25/21  

Pembersihan Lokasi 10 days 
Mon 

6/1/20 
Fri 6/12/20 

 

Pek. Pengukuran Dan 
Pemasangan Bouwplank 

2 days 
Mon 

6/15/20 
Tue 

6/16/20 
1 

Pek. Galian Tanah Biasa 
Sedalam 1 m 

12 days 
Wed 

6/17/20 
Thu 7/2/20 2 

Pek. Galian Tanah Biasa 
Sedalam 2 m 

9 days 
Mon 

6/22/20 
Thu 7/2/20 3FF 

Pek. Pengurugan Dengan 
Tanah Urug Setempat 

Bawah Pondasi 

5 days 
Fri 

7/3/20 
Thu 7/9/20 4 

Pek. Pengurugan Dengan 

Tanah Urug SetempaT 

Bawah Lantai 

8 days 
Fri 

7/3/20 

Tue 

7/14/20 
4 

Pek. Pengurugan Dengan 

Pasir Urug Bawah Pondasi 
1 day 

Fri 

7/10/20 
Fri 7/10/20 5 

Pek. Pengurugan Dengan 

Pasir Urug Bawah Lantai 
4 days 

Wed 

7/15/20 

Mon 

7/20/20 
6 

Pekerjaan Batu Kosong 

Anstamping 
4 days 

Tue 

7/21/20 
Fri 7/24/20 8 

Pek. Pondasi Batu Belah 

Campuran 1:5 
4 days 

Mon 

7/27/20 

Thu 

7/30/20 
9 

Pek. Lantai Kerja Bawah 

Pondasi T. 5 cm (K-175) 
2 days 

Wed 

7/15/20 

Thu 

7/16/20 
8SS 

Pek. Pembesian Pondasi 

Tapak P1 (100x100x25) 
3 days 

Fri 

7/17/20 

Tue 

7/21/20 
11 

Pek. Bekisting Pondasi 

Tapak P1 (100x100x25) 
9 days 

Wed 

7/22/20 
Mon 8/3/20 12 

Pek. Beton K-175 
Pembesian pondasi Tapak 

P1 (100x100x25) 

5 days 
Tue 

8/4/20 

Mon 

8/10/20 
13 

Pek. Sloof Type SL1 

15/25 
17 days 

Fri 

7/31/20 

Mon 

8/24/20 
10 

Pek. Sloof Type SL2 

15/20 
8 days 

Thu 

8/13/20 

Mon 

8/24/20 
15FF 

Pek. Kolom K1 30/30 32 days 
Tue 

8/25/20 

Wed 

10/7/20 
15 

Pek. Kolom KP 15/15 8 days 
Mon 

9/28/20 

Wed 

10/7/20 
17FF 

Pek. Balok Lintel BL 

15/15 
4 days 

Wed 

11/4/20 

Mon 

11/9/20 
20FF 

Pek. RingBalok RB 15/20 23 days 
Thu 

10/8/20 

Mon 

11/9/20 
17 

Pek. Pas. Dinding Bata 

Ringan T. 10 m 
40 days 

Tue 

11/10/20 
Mon 1/4/21 20 

Pek. Plesteran Tembok + 

Acian ad. 1:5 tebal 20 mm 
30 days 

Tue 

1/5/21 

Mon 

2/15/21 
21 

Pek. Keramik Dinding wc 

20x40 cm 
8 days 

Tue 

2/16/21 

Thu 

2/25/21 
22 

Pasangan Pintu Tipe P1 6 days 
Tue 

11/10/20 

Tue 

11/17/20 
21SS 

Pasangan Pintu Tipe P2 3 days 
Tue 

11/10/20 

Thu 

11/12/20 
21SS 

Pasangan Pintu Tipe P3 4 days 
Tue 

11/10/20 

Fri 

11/13/20 
21SS 

Pasangan Jendela Tipe J1 7 days 
Tue 

11/10/20 

Wed 

11/18/20 
21SS 

Pasangan Jendela Tipe J2 5 days 
Tue 

11/10/20 

Mon 

11/16/20 
21SS 

Pasangan Jendela Tipe J3 5 days 
Tue 

11/10/20 

Mon 

11/16/20 
21SS 
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Task Name Duration Start Finish Predecessors 

Pasangan Jendela Tipe 
BV1 

2 days 
Tue 

11/10/20 
Wed 

11/11/20 
21SS 

Pasangan Jendela Tipe 
BV2 

2 days 
Tue 

11/10/20 
Wed 

11/11/20 
21SS 

Pek Rangka Atap Baja 
Ringan  

17 days 
Tue 

11/10/20 
Wed 

12/2/20 
20 

Pas. Nok Genteng Metal 3 days 
Thu 

12/3/20 
Mon 

12/7/20 
32 

Pas. Listplank GRC 6 days 
Tue 

12/8/20 

Tue 

12/15/20 
33 

Pek. Pemasangan 

Wiremesh M10 Plat 

Lantai T. 12 cm 

4 days 
Tue 

12/8/20 
Fri 

12/11/20 
36 

Pek. Pemasangan 

Bekisting Plat Lantai T. 12 
cm 

20 days 
Tue 

11/10/20 

Mon 

12/7/20 
32SS 

Pek. Beton K-250 Plat 
Lantai T. 12 cm 

5 days 
Mon 

12/14/20 
Fri 

12/18/20 
35 

Pek. Ranga Besi Hollow 
Galvanis t = 0,5 + 

Gantungan  

10 days 
Mon 

12/21/20 
Fri 1/1/21 37 

Pek. Langit-Langit 

Plafond PVC  
6 days 

Mon 

1/4/21 

Mon 

1/11/21 
38 

Pek. Lantai Granite Tile 

Uk. 60x60 
26 days 

Tue 

1/12/21 

Tue 

2/16/21 
39 

Pek. Lantai Keramik 

25x25 Anti Slip 
2 days 

Wed 

2/17/21 

Thu 

2/18/21 
40 

Pek. Lantai Rabat Beton t. 

7 cm 
2 days 

Fri 

2/19/21 

Mon 

2/22/21 
41 

Kran Dinding 1/2 " Sek. " 

San ei "  
1 day 

Tue 

1/12/21 

Tue 

1/12/21 
39 

Kloset Jongkok sek. " 

Toto "  
3 days 

Wed 

1/13/21 
Fri 1/15/21 43 

Floor Drain Stainless 3 "  6 days 
Mon 

1/18/21 

Mon 

1/25/21 
44 

Pekerjaan Pemipaan Air 

Bersih Pipa PVC AW Ø 

3/4" 

3 days 
Tue 

1/26/21 
Thu 

1/28/21 
45 

Pekerjaan Pemipaan Air 

Kotor Pipa PVC AW Ø 
3/4" 

2 days 
Fri 

1/29/21 
Mon 2/1/21 46 

Pek. Pemasangan MCB 
Broco C25 (25 Ampere)  

1 day 
Mon 

12/21/20 
Mon 

12/21/20 
38SS 

Inst. Penerangan, Kabel 
NYM 3x2,5mm2 dlm 

conduit PVC  

1 day 
Tue 

12/22/20 

Tue 

12/22/20 
48 

Inst. Stopkontak, Kabel 

NYM 3x2,5mm2 dlm 

conduit PVC  

1 day 
Wed 

12/23/20 
Wed 

12/23/20 
49 

Lampu Downlight LED 

Philips DN027B 15 Watt 
6 inch - Kuning  

1 day 
Tue 

12/29/20 

Tue 

12/29/20 
56 

Philips Lamp PL-C 

827/2P White 2700K 18W 

+ Fiting  

1 day 
Wed 

12/30/20 

Wed 

12/30/20 
51 

Lampu Downlight LED 

Panel Outbow Putih Bulat 

18 Watt  

1 day 
Thu 

12/31/20 
Thu 

12/31/20 
52 

Saklar Ganda ex. 
Panasonic  

1 day 
Thu 

12/24/20 
Thu 

12/24/20 
50 

Saklar Tunggal ex. 
Panasonic  

1 day 
Fri 

12/25/20 
Fri 

12/25/20 
54 

Stopkontak ex. Panasonic  1 day 
Mon 

12/28/20 
Mon 

12/28/20 
55 

Pek. Pengecetan Tembok 
Baru Interior 

8 days 
Tue 

12/29/20 
Thu 1/7/21 56 

Pek. Pengecetan Tembok 
Baru Eksterior 

8 days 
Fri 

1/8/21 
Tue 

1/19/21 
57 

Task Name Duration Start Finish Predecessors 

Pek. Pengecetan Plafond 5 days 
Wed 

1/20/21 
Tue 

1/26/21 
58 

Pek. Pengecetan Listplank 4 days 
Wed 

1/27/21 
Mon 2/1/21 59 

 
C. Menentukan Normal Cost 

Perhitungan biaya mengacu kepada nilai 

Rencana Anggaran Pelaksanaan (RAP). Besarnya 

nilai RAP adalah hasil selisih dari nilai total proyek 

(RAB) dikurangi biaya tidak langsung. Untuk 

perhitungan biaya tidak langsung pada Tugas Akhir 

ini digunakan proporsi 10% dari nilai kontrak. 

Berikut adalah perhitungan rincian biaya langsung 

dan biaya tak langsung. 

RAP = Nilai Kontrak (RAB) – real cost  

    =  1.580.664.213,00  – (10% x 1.580.664.213,00) 

    =  1.580.664.213,00  –  1.580.664.213,00 

    =  1.422.597.792,04 

 

D. Menentukan Lintasan Kritis 

Setelah menemukan hubungan antar aktivitas, 

kegiatan  selanjutnya adalah menentukan aktivitas 

apa saja yang masuk kedalam lintasan kritis dari 

pekerjaan tersebut. Untuk menentukan lintasan 

kritis dilakukan dengan menggunakan  program 

Microsoft Project. 

Tabel  3 Daftar kegiatan-kegiatan kritis pada 

pekerjaan pembangunan gedung  

Nama Pekerjaan 
Durasi  

(Hari) 

Pembersihan Lokasi 10 

Pek. Pengukuran Dan Pemasangan 

Bouwplank 
2 

Pek. Galian Tanah Biasa Sedalam 1 m 12 

Pek. Galian Tanah Biasa Sedalam 2 m 9 

Pek. Pengurugan Dengan Tanah Urug 

Setempat Bawah Lantai 
8 

Pek. Pengurugan Dengan Pasir Urug 

Bawah Lantai 
4 

Pekerjaan Batu Kosong Anstamping 4 

Pek. Pondasi Batu Belah Campuran 

1:5 
4 

Pek. Sloof Type SL1 15/25 17 

Pek. Kolom K1 30/30 32 

Pek. RingBalok RB 15/20 23 

Pek. Pas. Dinding Bata Ringan T. 10 

m 
40 

Pek. Plesteran Tembok + Acian ad. 1:5 

tebal 20 mm 
30 

Pekerjaan Keramik Dinding Wc 20x40 

cm 
8 

 
E. Produktivitas Harian Normal dan Percepatan 

Alternatif penambahan jam kerja 3 jam dengan 

koefesien penurunan produktivitas 70%. 
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F. Cost Slope 

Setelah perhitungan produktivitas selanjutnya 

adalah menghitung crast cost dan crast duration 

sehingga nanti akan ditemukan besarnya cost slope 

atau nilai pertambahan biaya dalam batas waktu 

percepatan tersebut. 
 

Tabel 4. Produktivitas Harian Normal dan Percepatan 

Nama Pekerjaan Vol. 

Prod. 

Harian 

Normal 

Prod. Per-

jam 

Normal 

Prod. Setelah 

Percepatan 
Satuan 

Pembersihan Lokasi 858,6 85,86 10,7325 108,4    

Pek. Pengukuran Dan Pemasangan Bouwplank 135,7 67,85 8,481 85,661    

Pek. Galian Tanah Biasa Sedalam 1 m 158,22 13,185 1,648 16,646    

Pek. Galian Tanah Biasa Sedalam 2 m 102 11,333 1,416 14,308    

Pek. Pengurugan Dengan Tanah Urug Setempat 

Bawah Lantai 
158,28 19,035 2,379 24,032    

Pek. Pengurugan Dengan Pasir Urug Bawah Lantai 80,4 20,01 2,5125 25,376    

Pekerjaan Batu Kosong Anstamping 34.02 8,505 1,063 10,738    

Pek. Pondasi Batu Belah Campuran 1:5 8,75 2,1875 0,273 2,7617    

Pek. Sloof Type SL1 15/25 

Pekerjaan pembesian 1293,6 431,2 53,9 544,39 Kg 

Pekerjaan bekisting 126 11,45455 1,4318 14,461    

Pekerjaan beton 9,45 3,15 0,39375 3,9769    

Pek. Kolom K1 30/30 

Pekerjaan pembesian 2485,3 497,056 62,132 627,53 Kg 

Pekerjaan bekisting 306 15,3 1,9125 19,316    

Pekerjaan beton 22,95 3,278 0,956 5,2857    

Pek. RingBalok RB 15/20 

Pekerjaan pembesian 2044,4 511,1025 63,888 645,27 Kg 

Pekerjaan bekisting 208,08 13,872 1,734 17,513    

Pekerjaan beton 11,9 2,975 0,372 3,7599    

Pek. Pas. Dinding Bata Ringan T. 10 m 752,32 18,808 1,7912 22,57    

Pek. Plesteran Tembok + Acian ad. 1:5 tebal 20 

mm 
1504,6 50,15467 6,269 63,32    

Pasangan dinding keramik WC 54,85 6,8563 0,857 8,565    

 

Tabel 5. Cost slope total 

Penambahan Jam Kerja 

Nama Pekerjaan 
Durasi 

Percepatan 
Cost Normal Crash Cost Cost Slope total 

Pembersihan Lokasi 8 Rp   26.917.110,00 Rp 36.338.098,50 Rp      9.420.988,50 

Pek. Pengukuran Dan 

Pemasangan Bouwplank 
1,5 Rp     6.342.618,00 Rp      7.229.332,69 Rp         886.714,69 

Pek. Galian Tanah Biasa 

Sedalam 1 m 
9,5 Rp   12.459.825,00 Rp    16.645.554,75 Rp      4.185.729,70 

Pek. Galian Tanah Biasa 

Sedalam 2 m 
7 Rp     9.868.500,00 Rp    14.802.750,00 Rp      4.934.250,00 

Pek. Pengurugan 

Dengan Tanah Urug 

SetempaT Bawah Lantai 

6 Rp     8.756.100,00 Rp    11.081.939,10 Rp      2.325.839,06 

Pek. Pengurugan 

Dengan Pasir Urug 

Bawah Lantai 

3 Rp   20.622.600,00 Rp    21.295.321,88 Rp         672.721,88 
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Penambahan Jam Kerja 

Nama Pekerjaan 
Durasi 

Percepatan 
Cost Normal Crash Cost Cost Slope total 

Pekerjaan Batu Kosong 

Anstamping 
3 Rp   14.700.212,10 Rp    15.946.037,79 Rp      1.245.825,69 

Pek. Pondasi Batu Belah 

Campuran 1:5 
3 Rp     6.727.568,75 Rp      7.343.777,24 Rp          616.208,49 

Pek. Sloof Type SL1 15/25 

Pekerjaan pembesian 2 Rp   15.567.829,20 Rp     15.847.489,35 Rp       279.660,150 

Pekerjaan bekisting 9 Rp   18.674.460,00 Rp     23.083.006,70 Rp      4.408.546,70 

Pekerjaan beton 2 Rp     9.614.859,98 Rp     9.869.538,656 Rp       254.678,676 

Pek. Kolom K1 30/30 

Pekerjaan pembesian 4 Rp   29.909.102,16 Rp     31.411.826,71 Rp       1.502.724,55 

Pekerjaan bekisting 16 Rp   45.352.260,00 Rp     55.195.821,00 Rp       9.843.561,00 

Pekerjaan beton 4 Rp   23.350.374,23 Rp     29.535.531,19 Rp     6.185.156,960 

Pek. RingBalok RB 15/20 

Pekerjaan pembesian 3 Rp   24.603.428,08 Rp     25.541.257,18 Rp          937.929,10 

Pekerjaan bekisting 12 Rp   32.320.895,75 Rp     37.533.158,28 Rp     5.212.262,530 

Pekerjaan beton 3 Rp   12.102.514,22 Rp     12.789.109,43 Rp          686.595,21 

Pek. Pas. Dinding Bata 

Ringan T. 10 m 
33 Rp 231.880.514,04 Rp     243.189.724,9 Rp     11.309.210,86 

Pek. Plesteran Tembok + 

Acian ad. 1:5 tebal 20 

mm 

24 Rp 134.831.872,41 Rp   172.221.997,20 Rp   37.390.124,790 

Pasangan keramik 

dinding wc 
6 Rp   16.868.737,41 Rp     19.187.615,86 Rp       2.318.878,45 

Total 159 Rp  701,471,381.330 Rp    806,088,888.406 Rp 104.617.507,077 

 

IV. KESIMPULAN 
 

Berdasarkan serangkaian penelitian yang telah 

dilakukan yang dilanjutkan pada tahap analisa, 

maka dapat ditarik kesimpulan bahwa: 

1. Percepatan durasi yang dapat dilaksanakan dari 

penambahan jam kerja (jam lembur) dengan 

alternative jam kerja lembur 3 jam pada pada 

pekerjaan kritis adalah 44 hari dari durasi 

normal yaitu 203 hari menjadi 159 hari. 

2. Total biaya yang diperlukan dari penambahan 

jam kerja (jam lembur) dengan alternative jam 

kerja lembur 3 jam  pada pekerjaan di lintasan 

kritis adalah sebesar  Rp    806.088.888,406 dari 

biaya normal sebesar  Rp  701.471.381,330 

dengan cost slope sebesar  Rp  104.617.507,076. 

Nilai  kontrak RAB dari pembangunan gedung 

aula Nurul Jabbal untuk pekerjaan yang 

dilakukan penelitian adalah Rp 

1.580.664.213,00 , dimana nilai normal cost nya 

sebesar Rp 1.422.597.792,04, maka persentase 

cost slope untuk pembangunan gedung aula 

Nurul Jabbal adalah 7,35%. Sedangkan 

persentase cost slope dengan biaya total proyek 

adalah 5,96 % dimana total biaya keseluruhan 

proyek adalah Rp 1.754.274.213.38. 
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